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Wish I Knew: Retouch

In this lesson, we’re going to cover the essential concepts I wish I had known when 
I first started retouching images in Photoshop. 

The retouching tools

A lot of people get used to using one or two retouching tools and then rely sole-
ly on them. There are many great tools, however, and it’s a good idea to get ac-
quainted with all of them, as each one has its own particular strengths. 

The Spot Healing Brush  When using the 
Spot Healing Brush, it’s important to al-
ways use a hard-edged brush. If you use 
a soft-edged brush, it won’t have control 
over what’s happening toward the edges 
of the brush. This can result in an unap-
pealing fade-out. I usually use a brush that 
is set to 80-100% for the hardness set-
ting, but most of the time it’s maxed out 
at 100%. Make sure that the size of your 
brush is just large enough to cover the 
spot or object you want to remove. Also 
make sure that the circle itself is touch-
ing an area that has the proper color and 
brightness that should be used to replace 
the area inside. 

The Spot Healing Brush works best when the area you’re trying to retouch does 
not have to be filled with something specific in order for it to look good. It will 
work well when the tool can choose from a large amount of surrounding area to 
determine what to place in the retouch location. It will NOT work as well when the 
retouch area needs to be filled with something specific. An example would be a 
wall with a specific pattern on it. In order for the retouch area to look correct, the 

The Spot Healing Brush can be accessed 
from within the Toolbar.

When using the Spot Healing Brush, make 
sure the tool is just large enough to cover 
the spot you’re trying to remove.
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pattern must be perfectly matched, and this is not something the Spot Healing 
Brush is good at. In an instance like this, the Healing Brush will do a better job. 

The Healing Brush The Healing Brush is better 
at retouching areas that have a pattern or are 
more detailed. That’s because, when using the 
Healing Brush, you can tell Photoshop where to 
copy from. Hold down the Option key (Alt on 
Win) and click on the area you’d like to copy 
from. Then, release the Option key and paint 
over the area you need to retouch. The cursor 
will display a preview of what you are copying 
from so that you can accurately line up any pat-
terns or objects. 

Whenever you use a tool with the word “healing” at-
tached to it, the tool will look at the content that is 
directly touching the edges of the circular tool tip and 
attempt to match the color and brightness of that 
area. Because of this, it doesn’t matter what color is 
in the area you’re copying from. It is essentially using 
that source area to copy the texture, or the variation 
in brightness. In the video example, we used the Heal-
ing Brush to sample an area from the white brick wall 
and then paint over an area in the red, wood door. As 
a result, the color was correct (red), but we painted in 
the brick texture onto the wood wall. The Healing Brush 
matched the surrounding color of the retouch area but 
inserted the texture from the sample area. 

Content-Aware Fill This command works in the same way as the Spot Healing 
Brush. The difference is that, with the Content-Aware Fill command, you start by 
creating a selection around the area you want to retouch. There is no painting 
tool like there is with the Spot Healing Brush. With the selection active, go to the 

When retouching with the Healing 
Brush, the round tool tip will dis-
play a preview of what you’ll be 
painting in.

The Healing Brush matched 
the color of the retouch 
area but used the texture 
from the sample area.
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Edit menu and choose Fill. 
In the dialog that appears, 
make sure that the Con-
tents menu is set to “Con-
tent-Aware” and that the 
Opacity setting is at 100%. 
Then click OK. Photoshop 
will attempt to fill in the se-
lected area based on what 
it sees in the surround-
ing areas. Sometimes this 
works perfectly on the first 
try. Other times, you may 
need run the Fill command 
again or fine-tune the area 
with another tool. 

The Patch Tool The Patch Tool is hidden behind the Spot Healing Brush and the 
Healing Brush in the Toolbar. It works in a similar way to the Healing Brush. With 
the Patch Tool, you start with a selection around the area you want to retouch. 
You can create the selection with any selection tool you’d like, and if there is not a 
selection already active, you can use the Patch Tool itself to draw out a selection. 
Then, click somewhere inside the active selection and drag your cursor to the area 
you want to copy from. As you drag with your mouse, you’ll see a preview of what 
the selection will be filled with if you were to release the mouse button. When you 
release the mouse button, the selected area will be filled with the content from the 
area you specified. 

The Content-Aware 
Fill command is 
being used to fill 
the are inside the 
selection based on 
the content in the 
surrounding area.

A selection was created 
using the Patch Tool and 
then the contents of the 

selection is being dragged 
to the location we want the 

tool to sample from.
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Aligned setting for Clone Stamp Tool and Healing Brush  When working with 
the Clone Stamp Tool or the Healing Brush, there is a setting I wish I had known 
about much earlier, and that is the Aligned setting. After clicking to apply some 
healing or cloning to an area, the preview inside the round tool tip may no longer 
remain lined up after you move your mouse away from the area.  I like the preview 
to remain aligned and to maintain the relationship between the area I sampled 

from and the area I am retouching. To 
ensure this relationship is maintained, 
I’ll turn on the Aligned setting, which 
can be found in the Options Bar above 
the main image window. The Aligned 
setting determines what happens if 
you click once with the tool and then 
release the mouse button. If the setting 
is on, it will remain aligned when you 
move your mouse around. 

The Clone Stamp Tool  Any of the tools with the words “heal” or “content-aware” 
in the name is going to try and blend the target area in with the surroundings. 
Sometimes, however, you don’t want that. In these cases, you would use the Clone 
Stamp Tool. This tool is used to blatantly copy the content from one area and place 
it in another area (without trying to do anything fancy). It can be very useful when 
the area you need to retouch needs to contain very specific content. For example, 
let’s say the retouch area contains some kind of seam that needs to follow a spe-
cific path. The other retouching tools could mess things up when attempting to fill 
the area. With the Clone Stamp Tool, you can carefully copy from a specific area of 
the image that contains the same type of seam and paste the content into the area 
you need to retouch. In other words, it’s a much more manual way of retouching. 

Rotate the source area With the Clone Stamp Tool and the Healing Brush, you can 
copy from one source area and then rotate the content in order to correctly paste 
it into your target area. In the video example, we wanted to copy a horizontal bor-
der on the sign and paste the content in a vertical fashion. 

The Aligned setting can be found within the 
Options Bar when the Clone Stamp Tool or 
the Healing Brush is active. 
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To do this, use the Clone Stamp Tool or the Healing Brush (we’re using the Heal-
ing Brush in the video), hold down the Option key (Alt on Win) and click on the 
area you’d like to copy from. Then, position your mouse over the area you’d like 
to retouch. The preview inside the circular tool tip will show you the angle of the 
content you’re going to paste. 

Hold down Shift+Op-
tion (Shift+Alt on Win) 
and then use the great-
er-than and less-than 
keys ( > < ) to rotate that 
content you’re going to 
apply.  You can also scale 
the content you’re going 
to clone or heal by hold-
ing down Shift+Option 
(Shift+Alt on Win) and 
then using the bracket 
keys ( [  ] ) to make the 
content larger or smaller. 

Note that after rotating or scaling the sampled con-
tent, there is no keyboard shortcut to reset the tool 
back to its default settings. You can, however, reset 
the tool from within the Clone Source panel. The 
Clone Source panel contains all of the settings for the 
keyboard shortcuts we just mentioned and you can 
access it by going to the main menu at the top of the 
screen and choosing Window > Clone Source. Reset 
all of the transform settings by clicking the Reset but-
ton on the right side of the panel. It looks like a round-
ed u-turn arrow. 

Left: The Clone Stamp Tool is being used to copy from a line 
on the sign. Center: We want to paste the copied content to 
a different part of the sign, but it doesn’t line up. Right: The 
copied content was rotated so that it lines up with the area 
we want to retouch.

The Reset button within the 
Clone Source panel.
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Create keyboard shortcut to reset Clone Source settings  Personally, I rarely need 
the Clone Source panel open and I didn’t want to have to open it just so I could 
hit that Reset button. To get around this, I created a custom keyboard shortcut for 
the Clone Source Reset button. Let’s look at how to do that. Go to the Edit menu 
and choose Keyboard Shortcuts. In the dialog box that pops up, set the “Short-
cuts For” menu to Panel Menus. This will present you with a list of all the different 
Photoshop panels available. Click on the little disclosure triangle to the left of the 
Clone Source option and it will expand to show you all of the options within the 
little side menu for the Clone Source panel. Click on the “Reset Transform” option 
and a text field will become available for you to type in a custom keyboard short-
cut. I used the following shortcut: Shift+Option+Command+R. When I entered this 
shortcut, a warning appeared, letting me know that the chosen shortcut was al-
ready in use for the 3D Render command and, if I continued, the shortcut would 
be removed from that command and applied to the Reset Transform command. 
I, personally, don’t use the 3D features so I was fine with “stealing” that shortcut. 
Click OK when you’re done entering your custom shortcut. 

Here, we’re 
creating a 
custom key-
board shortcut 
for the Clone 
Source Reset 
button.



Wish I Knew: Retouch  © Ben Willmore, All rights reserved 8

Working with layers  When retouching your 
images, there are two ways that you can use 
layers. With the first method, you would du-
plicate the background/image layer and then 
do your retouching on the duplicate. The 
problem with this method is that you double 
your file size by duplicating the layer. With 
the second method, you would create a new, 
empty layer and then do your retouching on 
this layer. This second method is much more 
versatile and doesn’t force you to double your 
file size. When you do your retouching on an 
empty layer, there are some settings that you 
need to be aware of. When using the Clone 
Stamp Tool or the Healing Brush, there is a 
Sample menu in the Options Bar at the top 
of the image window. In order for the tool to 
work on an empty layer, this menu should be 
set to sample Current & Below. If you keep it 
set to sample the Current layer only, the tool will have nothing to sample from 
since the layer is empty. When using the Spot Healing Brush, the setting will in-
stead appear as a “Sample All Layers” check box or button within the Options Bar.  

Note that the Content-Aware Fill command will NOT work on an empty layer. It 
needs actual content to work with and will present you with an error message if 
you try to use the command on an empty layer. Therefore, if you want to use the 
command without affecting the original background layer, you will need to dupli-
cate that image layer and then run the Content-Aware Fill command on the layer 
duplicate. 

The retouch work is being done on an 
empty layer.

When a retouching tool is active, the 
Sample setting can be found within the 
Options Bar above the image window.
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16-bit mode for retouching smooth skies If you’re ever doing any retouching on a 
sky, especially if it’s a blue sky that doesn’t have any clouds, it’s best to work in 16-
bit mode. When working in 8-bit mode, Pho-
toshop has access to 256 brightness levels 
in the image. In 16-bit mode, Photoshop has 
access to thousands of brightness levels. 
Because of this, the results you’ll get when 
retouching skies will be much smoother. You 
can tell what mode your picture is in by look-
ing at the document tab directly above the 
image window. At the end of the line of text, 
it will include the color space and whether 
it’s in 8-bit, 16-bit or 32-bit mode. To change 
the mode of your image, go to the Image 
menu and choose Mode. There, you can 
choose between 8-, 16- or 32-bit mode. 

Cloning between documents  Photoshop’s retouching tools also allow you to 
clone between documents. Start in the document you’d like to copy from and 
Option+Click to specify a sample area. Then switch to the document you’d like to 
paste that content into. Within the circular tool tip, you’ll see a preview of the con-
tent you’ll be pasting. You can then paint in the sampled content from the other 
document. 

Soft-edged vs. hard-edged brushes  Any time you’re using a healing tool (Spot 
Healing Brush, Healing Brush), be sure to use a hard-edged brush. If you use a 
soft-edged brush, the tool won’t have control over what’s happening toward the 
edges of the brush. Any time you’re using a cloning tool (Clone Stamp Tool), you 
need to be careful of how hard the brush edge is because you’ll need it to be soft 
enough so that it blends in with the surroundings. 

Looking at the Photo-
shop document tab, we 
can tell this image is in 
16-bit mode.

To change the mode of your document, 
go to the Image menu and choose Mode.


